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Terminologies 

MSOP Main data Stream Output Protocol 

DIFOP Device Info Output Protocol 

FOV Field Of View 

PTP Precision Time Protocol 

NTP Network Time Protocol 

GPS Global Positioning System 

UTC Universal Time Coordinated 

Wave_mode Echo flag 

Protocol 
Protocol version number, 00 represents old version, 01 represents the latest 

version 

Temp Sensor temperature information 

Resv Reserved data flag  

Azimuth LiDAR horizontal rotation angle 

Timestamp Time stamp which is used to record system time 

Header Frame header in protocol packet 

Tail Frame tail in protocol packet  

Value 
The decimal value obtained after conversion of the corresponding offset byte, 

using big-endian mode, with the high bit in the front and the low bit in the back 
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1. Manufacturer Information 

Suteng Innovation Technology Co., Ltd. (RoboSense) 

Building 9, Block 2, Zhongguan Honghualing Industry Southern District, 1213 Liuxian Avenue, 

Taoyuan Street, Nanshan District, Shenzhen, China 

Landline: 0755-86325830 

Mobile Phone: +86 15338772453(Marketing & Sales Cooperation) 

Email: service@robosense.cn (New) 

Working hours from Monday to Friday 09:00-18:00(GMT/UTC +8) 

2 Disclaimer of Liability 

This manual is protected by copyright. Any rights arising from this copyright are owned by 

RoboSense. Reproduction of this manual or part of the manual is only permitted within the legal 

scope of the copyright law. Without obtaining any authorization, this document shall not be 

abridged or translated. The trademarks mentioned in this document are the property of their 

respective owners. RoboSense reserves all rights. 

3 Certifications 

 

 

 

特别说明： 

This manual is updated from time to time without prior notice, to get the latest version, please visit 

RoboSense company website to download or contact the RoboSense Technical Support or Sales. 
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1 Safety Notices 

To avoid risks of accidents, damage to sensor or violating of your product warranty, please read 

and follow the instructions in this manual carefully before operating the product. 

 Laser Safety 

This product meets the following standards for laser products:  

IEC 60825-1:2014;  

          

 Please pay attention to the overheating sign on the LiDAR surface to avoid a hot LiDAR surface 

that may lead to sensor failure or undesirable consequences. 

 

 Retain Instructions - The safety and operating instructions should be retained for future 

reference. 

 Heed Warnings - All warnings on the product and in the operating instructions should be 

adhered to. 

 Servicing – Except for what’s described in this manual, the sensor has no field serviceable 

parts. For servicing, please contact RoboSense sales or the authorized distributors. 
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2 Helios Series Products 

No. 
Model Number of Channels FOV Remark 

1 
Helios-5515 32 -55°~+15° Wide FOV 

2 
Helios-1615 32 -16°~+15° Uniform 1°Vertical 

Resolution 

3 
Helios-16P 16 -15°~+15° Uniform 2°Vertical 

Resolution 

This manual is for the Helios-16P product 
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3 Product Appearance and Interface 

3.1 Product Appearance 

 

Figure 1 LiDAR Coordinate and Rotation Direction 

3.2 Aviation Plug and Pin Definition 

RS-Helios-16P has an aviation plug attached to the bottom of the LiDAR, the definitions of the 

specific pins of the aviation plug are as shown in the table below: 

                                                            

Pin Color Function 
Operating 

Voltage Range 
Working Current Other 

1 Red PWR 
9~32V 1.2A 

/ 

2 Black PWR 

3 Gray GND 
/ 1.2A 

4 Blue GND 

5 Brown GPS_PPS 3~15V 

/ 

6 White GPS_GPRMC -15V~+15V 

7 Purple SYNC_OUT1 

0~3.3V 
8 Green SYNC_OUT2 

9 Orange TRD_N 
Twisted Pair 

10 Yellow TRD_P 

Figure 2 Definition of Pins of Aviation Plug 

3.3 Interface Box 

The RS-Helios-16P comes with an Interface Box, which has 2 LED lights and provides convenient 

connection to power, RJ45 Ethernet, and GPS. (The length of the integrated cable attached to the 

 

- 

Aviation plug interface side 
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Interface Box of the aviation plug version LiDAR is 3 meters, for other cable lengths, please contact 

RoboSense technical support). 

 

Figure 3 Definition of Interface Box Ports 

Specifications of Interface Box ports:  

Table 1 Interface Box Port Specification  

No. 
Port Specification 

1 
Power Input Standard DC 5.5-2.1 connector 

2 
Network  Standard RJ45 Ethernet connector 

3 
GPS timing SH1.0-6P Female connector 

3.3.1 Power 

The power supply interface on the Interface Box is a standard DC 5.5-2.1 connector. 

There are 2 LEDs in the Interface Box: when the power input is normal, the red LED lights up; when 

the power output is normal, the green LED lights up. If the power indicator is dimmed, the Interface 

BOX may not work properly. Please check whether the power input is normal. If the power input is 

normal, the Interface BOX may be damaged. Please contact RoboSense technical support & sales 

for help. 

3.3.2 RJ45 Ethernet Port 

The network interface on the Interface Box follows the EIA/TIA568 standard. 

3.3.3 GPS Time Synchronization 

RS-Helios-16P uses GPS for Time Synchronization: the GPS REC receives GPS UART standard input; GPS PULSE 
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receives GPS PPS information input. 

The definitions of pins of the GPS port are detailed in the figure below:  

Table 2 GPS Port Definition 

Pin No. 
Function 

1 GPS_PPS 

2 +5V 

3 GND 

4 GPS_GPRMC 

5 GND 

6 SYNC_OUT1 

Note: When the "ground" of RS-Helios-16P is connected to an external system, the negative polarity ("ground") of 
the external system and the "ground" of the GPS system must share a non-isolated common ground. 
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4 Unboxing & Installation 

4.1 Standard Package  

The table below lists the contents of a standard RS-Helios-16P package from the factory.  

Table 3 Standard Factory Package of the RS-Helios-16P 

No. Contents SPEC/QTY  

1 LiDAR RS-Helios-16P*1 

2 Interface Box 3M *1 

3 Power Adapter DC12Vx3.34A/40W *1 

4 Power Cable 1.2M *1 

5 Ethernet Cable 1.5M *1 

6 Screw Pack M3X8 *4, M3X12 *4 

 
Note: There might be variants of the sensor and accessories that you are going to purchase or interested in, please 
confirm the details with RoboSense Sales. 

4.2 Sensor Mounting 

 

Figure 4 LiDAR Mounting Details 

3xM3 Screws, 4-5mm above mounting surface; 
13±1kgf.cm recommended tightening torque 

2xΦ4 locating pins, 4-5mm above mounting surface 
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 Screw Specifications 

GB/T70.1, M3x12, hexagon socket head, material SCM435, electroplated trivalent chromium black 

zinc, grade 10.9, with drop resistance coating. 

GB/T70.1, M3x8, hexagon socket head, material SCM435, electroplated trivalent chromium black 

zinc, grade 10.9, with drop resistance coating. 

 Mounting Requirements 

1) The mounting surface should be as flat as possible with the flatness be better than 0.05mm;  

2) Use 3xM3 mounting screws to fix the LiDAR on the mounting surface, the screw should be 

4~5mm above the mounting surface, the recommended tightening torque is 13±1kgf.cm; 

3) Use 2xΦ4 locating pins to locate the LiDAR on the mounting surface, the pin should be 4~5mm 

above the mounting surface. 

 

Figure 5 LiDAR Mounting Holes & Locating Holes Diagram 

 Mounting Bracket Rigidity Requirements 

The mounting bracket where the LiDAR is attached to should be rigid enough to ensure LiDAR in a 

stable operating state under various working conditions. Therefore, it is required that the first-

order modal frequency of the LiDAR and the mounting bracket should be greater than 50Hz, and 

avoiding frequency range of 100~110Hz and 280-290Hz; 

The LiDAR will be subjected to various random vibrations, mechanical shocks and other operating 

conditions during use. Under these conditions, the bracket needs to be strong enough to bear a 

relatively large load. 

Make sure the following requirements are met when mounting the LiDAR: 

1) The mounting surface of the LiDAR should be flat and uneven surfaces should be avoided.  

2 Locating holes 

3xM3 Mounting holes 
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2) The precise locator pins on the mounting base should strictly follow the dimensions of the 

locator holes at the bottom of the LiDAR, and the height of the locator pin should not be 

higher than 4mm. We recommend using aluminum alloy for the mounting base material, 

which facilitates heat dissipating of the LiDAR during operating.  

3) If there are contact mounting surfaces on the top and bottom of the LiDAR, please ensure that 

the distance between the mounting surfaces is greater than the height of the LiDAR to avoid 

squeezing the LiDAR. 

4) When connecting cables of the LiDAR, make sure not to pull the cable too tightly, and keep 

the cables in a slack state. 

4.3 Quick Connection 

Users are allowed to configure the network settings of the RS-Helios, which is set at the factory 

with default IP and port numbers, as shown in the table below: 

Table 4 Factory Default Network Configuration 

 
IP Address MSOP Port No. DIFOP Port No. 

RS-Helios-16P 
192.168.1.200 

6699 7788 

Computer 
192.168.1.102 

To establish communication between the LiDAR and computer, it’s required to set the computer's 

IP address to the same network segment as the LiDAR, for example 192.168.1.x (the value of x 

could be from 1 to 254), and the subnet mask to 255.255.255.0. If you don't know the network 

configuration of the LiDAR, please connect the LiDAR to computer and use wireshark to capture 

the LiDAR data packets to analyze.  
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The wiring diagram of the Interface Box connection is as shown in the figure below: 

 

 

 

 

 

 

 

 

    

 

 

 

    

 

 

 

 

 

 

 

 

 

 

 

Figure 6 Interface Box Connection 
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5 Sensor Specifications and Features 

5.1 Sensor Specification1 

5.1.1 Parameters 

Sensor 

Laser Channels 16 FOV(Horizontal) 360° 

Laser Wavelength 905nm FOV(Vertical) 
﹢15° to -15°(30° 

in total) 

Laser Emission Angle 
(Full Angel) 

Horizontal: 1.6mrad  
Vertical: 6.9 mrad 

Angular Resolution 
(Horizontal) 

0.2°/ 0.4° 

Laser Safety  Class 1 Eye-safe 
Angular Resolution 
(Vertical) 

2° 

Measurement Range 
0.2m to 150m (90m @10% 
Reflectivity NIST, refer to Table 5) 

Ranging Accuracy 
(Typical)2 ±2cm 

Blind Distance 0.2m Frame Rate 10Hz/ 20 Hz 

Rotation Speed 
600/ 1200 rmp(10/20Hz) 

Output 

Data Rate 
288,000pts/s (Single Return Mode); 576,000pts/s (Dual Return Mode) 

Ethernet 
100M-Base-T1 

Data Output Protocol 
UDP packets over Ethernet 

UDP Packets Content 
3D Coordinates, Calibrated Reflectivity Measurements, Time Stamps 

Mechanical 

Operating Voltage 9V - 32V Dimension 
φ97.5mm * H100 
mm 

Power Consumption 11W(Typical) 
Operating 
Temperature3 

-30℃ to +60℃ 

Weight 0.99kg(LiDAR body) Storage Temperature -40℃ to +85℃ 

Time Synchronization $GPRMC with 1PPS，PTP&gPTP Sensor Protection IP67 

                                                                 
1 The data above is only for serial production products, and may not be applicable to any samples, testing devices 

and other non-production versions. If you have any questions, please contact RoboSense Sales. 
2  The ranging accuracy takes a 50% NIST diffuse reflector as the target. The test results may be affected by 

environment conditions, including but not limited to factors such as ambient temperature and target distance. 
The accuracy value is applicable to most channels, and there may exists differences between some channels. 

3 The operating temperature of the device may be affected by environment conditions, including but not limited 
to factors such as ambient light and airflow changes. 
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Table 5 Ranging Capability of LiDAR Channel 

Channel No. Vertical Angle（°） 10% NIST（m） Range（m） 

1 13° 90 120 

2 15° 90 120 

3 9° 90 150 

4 11° 90 120 

5 5° 90 150 

6 7° 90 150 

7 1° 90 150 

8 3° 90 150 

9 -3° 90 150 

10 -1° 90 150 

11 -7° 90 150 

12 -5° 90 150 

13 -11° 90 120 

14 -9° 90 150 

15 -15° 90 120 

16 -13° 90 120 

 

5.2 Point Cloud Display 

5.2.1 Coordinate Mapping 

Since the data packet output by the LiDAR only provides the horizontal rotation angle and 

distance parameters, in order to present a 3D point cloud image, the angle and distance 

information in polar coordinates need to be converted into x, y, z coordinates in the Cartesian 

coordinate system, and the conversion formula is as follows: 

{

𝑥 = 𝑟 𝑐𝑜𝑠( 𝜔) 𝑠𝑖𝑛( 𝛼);
𝑦 = 𝑟 𝑐𝑜𝑠( 𝜔) 𝑐𝑜𝑠( 𝛼);
𝑧 = 𝑟 𝑠𝑖𝑛( 𝜔);

  

Where 𝑟  is the measured distance,   is the vertical angle of the laser,   is the horizontal 

rotation angle of the laser in the Polar Coordinate System, and x, y, z are the coordinate values in 

the Cartesian Coordinate System. 

Note 1: ROS source code of RS-Helios-16P has by default completed the coordinate conversion to conform to the 
right-handed coordinate system of ROS. The X-axis of ROS is the positive Y direction in Figure 1, and the Y-axis of 
ROS is the negative X direction in Figure 1.  

Note 2: The origin of the LiDAR sensor coordinate is 63.5mm above the LiDAR base, on the center axis.  

 

 

 



                                                  RS-Helios-16P User Manual                                                                                                        

 12 

5.3 Reflectivity 

RS-Helios-16P measures the reflectivity of objects. The reflectivity is an index that measures the 

ability of an object to reflect light and is greatly related to the material of the object itself. Therefore, 

the reflectivity information can be used to distinguish objects of different materials. 

RS-Helios-16P reports calibrated reflectivity values from 0 to 255, among which diffuse reflectors 

report values from 0 to 100, and retroreflectors report values from 101 to 255. Black objects are 

with low reflectivity values, white objects are with high reflectivity values, the most ideal reflection 

reports the reflectivity value of 255.  

 

 Figure 7 Definition of Reflectivity  

5.4 Laser Return Modes 

5.4.1 Principle of Laser Return Modes 

RS-Helios-16P supports multiple laser return modes, namely: Strongest, First, Last and Dual. When 

set to Dual Return mode, the details of the target will increase, and the volume of data is twice 

that in the Single Return mode.  

Due to beam divergence, multiple laser returns are possible from any single laser shot. After a laser 

pulse is hot, the beam size becomes larger and larger as it travels in the air, when a beam is large 

Diffuse Reflectors 

Black, absorbent diffuse reflector  

Reflectivity ≈0 

White, reflective diffuse reflector  

Reflectivity <100 

Retro-Reflectors 

Retro-reflector covered with semi-

transparent white surface 

Reflectivity>100 

Retro-reflector without any coverage 

Reflectibity≈255 
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enough to hit multiple objects, it will produce multiple reflections.  

RS-Helios-16P analyzes the received multiple returns, and can be set to only report the strongest 

return, first return or the last return each time, or the strongest and last return, the strongest and 

first return, the first and the last return at the same time, depending on the laser return mode 

settings. If it is set to the strongest return mode, only the value of strongest return will be reported. 

Similarly, if is set to the last return mode, only the value of the last return will be reported. 

Note:  

1. The sensor records two returns only when the distance between two objects is 1 meter or more. 
2. When a laser pulse hits only one object, there is only the strongest return. 

3. When a laser pulse hits two solid walls or other objects at two different distances, two returns will be produced. 
In this case, there are two situations: 
(1) When the strongest return is not the last return, the strongest and last return will be reported; 
(2) When the strongest return is the last return, the strongest return and the second strongest return will be 

reported. 

5.4.2 Return Mode Flag 

The RS-Helios-16P is set in the Strongest Return mode at factory by default. If you need to change 

this settings, please refer to Appendix A.2 in this user manual for instructions. The 300th byte in a 

DIFOP packet is the flag of return mode, which corresponds to the following:  

Table 6 Return Mode Flag 

Flag 
Return Mode 

00 Dual Return 

04 Strongest Return 

05 Last Return  

06 First return 

 

5.5 Phase Locking 

The phase locking feature, when a PPS pulse signal is triggered, askes the RS-Helios-16P to rotate 

to a specific angle to fire laser pulses. When multiple RS-Helios-16P sensors are used at the same 

time, the relative rotation angle between them is kept unchanged. The normal phase locking 

requires the normal and stable PPS pulse triggering signal. 

Figure 7 shows the RS-Helios-16P set with different phases. The red arrows indicate the firing angle 

of the sensor’s laser at the moment it receives the rising edge of the PPS signal. In the cases below: 

0 degrees, 135 degrees, and 270 degrees respectively. 
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Figure 8 RS-Helios-16P Different Phase Settings 

Using the RS-Helios-16P Web Interface, users can check and modify the Phase Locking settings, 

click Setting > Phase Lock Setting, for the "Phase Lock" parameter setting. The phase locking value 

can be set from 0 to 359. 

5.6 Time Synchronization 

RS-Helios-16P supports GPS+PPS and PTP time synchronization methods. Users can use the RS-

Helios-16P Web Interface to set the time synchronization modes. (Please refer to Appendix A.2 for 

detailed instructions of setting by using Web Interface.)  

RS-Helios-16P can be connected to an external GPS module and can synchronize the sensor system 

time with the time provided by the GPS.  

5.6.1  GPS Time Synchronization 

 

 Figure 9 GPS Time Synchronization Timing Diagram 

The GPS module continuously sends GPRMC message and PPS synchronization pulse signals to the 

sensor. The PPS synchronization pulse width is from 20ms to 200ms, and the GPRMC message must 

be sent within 500ms after the rising edge of the PPS synchronization pulse. 

5.6.2 The Use of GPS for Time Synchronization 

The GPS_REC interface in the Interface Box of the RS-Helios-16P follows the RS232 level standard, 

as shown in the table below: 

Reset part of sub-second According to GPRMC message, synchronize the part of second 
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Table 7 GPS Receive Pin Definition  

Level 
Receive Pin Definition 

GPS REC GPS PULSE 

RS232 

Receive the RS232 serial data 

output by the GPS module 

Receive the positive 

synchronization pulse signal 

output by the GPS module, the 

level is required to be 

3.0V~15.0V 

Note 1: The GPS_REC interface in the RS-Helios-16P Interface Box is the SH1.0-6P female connector, and the pin 
definition is as shown in Figure 2. 
 

The external GPS module needs to set the serial output baud rate to 9600bps, 8 bits, no parity, 1 

stop bit. RS-Helios-16P only accepts the GPRMC sentence sent by the GPS module. The standard 

structure of the GPRMC sentence is as follows: 

$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh 

<1> UTC Time  

<2> Receiver status, A=active, V=void 

<3> Latitude 

<4> Latitudinal hemisphere N (northern hemisphere) or S (southern hemisphere) 

<5> Longitude 

<6> Longitudinal hemisphere E (east longitude) or W (west longitude) 

<7> Speed over the ground(knots) 

<8> Track made good (degrees True) 

<9> UTC date  

<10> Magnetic declination 

<11> Magnetic declination direction, E (east) or W (west) 

<12> Mode indicator (A=autonomous, D=differential, E=estimated, N=not valid) 

* The last hh is the XOR sum of all characters from $ to * 

Note: 
1. The sending time interval of 1 PPS pulse needs to be controlled within 1s±100us; 
2. The status bit in the GPRMC message must be A valid before time synchronization is allowed; 
3. The length of GPRMC messages sent by existing GPS modules on the market is not consistent. 
The length of GPRMC messages reserved in the DIFOP packet of RS-Helios-16P is compatible with 
the GPRMC message format sent by most GPS modules on the market. If any incompatibility occurs, 
please contact RoboSense technical support. 

5.6.3 PTP Time Synchronization  

PTP (Precision Time Protocol) is a time synchronization protocol, which itself is only used for high-

precision time synchronization between devices, but it can also be borrowed for frequency 
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synchronization between devices. Compared with various existing time synchronization 

mechanisms, PTP has the following advantages:  

1) Compared with NTP (Network Time Protocol), PTP can meet higher-precision time 

synchronization requirements. NTP can generally only achieve sub-second time synchronization 

accuracy, while PTP can reach sub-microsecond time synchronization accuracy. 

2) Compared with GPS (Global Positioning System), PTP has lower construction and maintenance 

costs, and can be used independently from the GPS. 

5.6.4 PTP wiring Method  

To use the PTP synchronization method, you need to make the following preparations, and then 

connect according to the connection method shown in the figure below: 

1) Select PTP mode in the web interface (please see Appendix A.2 Web Interface configuration); 

2) Prepare a PTP Master timing host (plug and play, no additional configuration required); 

3) Ethernet switch; 

4) Device supporting PTP protocol  

 

 

 

    

Figure 10 PTP Connecting Diagram 

Note:  
1. The PTP Master timing equipment is a third-party equipment that needs to be purchased by the user 
independently, which is not included in the RoboSense standard product shipping package. 
2. As a PTP Slave device, our LiDAR only obtains the time sent by the PTP Master, and does not make accuracy 
judgments. If the time of the LiDAR deviates from the real time, please check whether the time provided by the PTP 
Master is accurate; 
3. After the LiDAR is synchronized, the PTP Master is disconnected, and the time in the point cloud data packet will 
be superimposed according to the LiDAR's internal clock, and it will be reset after the LiDAR is powered off and 
restarted. 
 
 
 
 
 
 
 
 
 

PTP Master (third party) 

Ethernet Switch 

LiDAR Configuration 

Box 
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6 Communication Protocol 

The communication between RS-Helios-16P and computer is through Ethernet and by sending UDP 

packets. There are mainly two types of communication protocols, as shown in the following table: 

Table 8 Communication Protocols 

Protocol 
Abbreviation Function Type Packet Size 

Main data Stream 

Output Protocol 

MSOP 
Output measured 

data 
UDP 1248 bytes 

Device Information 

Output Protocol 

DIFOP 
Output sensor 

information 
UDP 1248 bytes 

Note: The following sections describe and define the valid payload (1248byte) of the protocols. 

1) The main data stream output protocol MSOP, encapsulates the distance, angle, reflectivity and other 
information measured by the LiDAR into an UDP packet and outputs to the computer; 

2) Device information output protocol DIFOP, outputs various configuration information of the current state 
LiDAR to the computer; 

6.1 MSOP and DIFOP 

The UDP packet sent by RS-Helios-16P has a payload of 1248 bytes, the data structure of the main 

data stream output protocol (MSOP) and device information output protocol (DIFOP) is as shown 

in the figure below: 

 

Figure 11 UDP Packet Structure 
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6.2 Main Data Stream Output Protocol（MSOP） 

Main data Stream Output Protocol is abbreviated as MSOP 

I/O type: device output, computer analysis 

Default port number: 6699 

6.2.1 Header 

The header has 42 bytes and is used to identify the beginning of the UDP data packet. The structure 

of the Header is as shown in the table below:  

 Table 9 MSOP Header 

Header (42 bytes) 

Field Offset 
Length 

(byte） 
Description 

Header ID 0 8 55_aa_05_5a 

Protocol Version 4 2 00_01 

Resv 6 2  

Top Board Sending 
Packet Count 

8 4 
4 Bytes in total, form a sequence with a increment 
of 3 

Bottom Board 
Sending Packet 
Count 

12 4  

Resv 16 1  

Range Resolution  17 1 1: 0.25cm；0：0.5cm 

Angle pulse interval 
count 

18 2 Unit: us 

Timestamp 20 10 
First 6 Bytes are second bits, last 4 bytes are 
microsecond bits 

Resv 30 1  

LiDAR Model 31 1 

Identify LiDAR model 
0x01:RS--LiDAR-16 
0x02:RS-LiDAR-32 
0x03:RS-Bpearl 
0x04:RS-Ruby 
0x05:RS-Ruby Lite 
0x06:RS-Helios-5515 

0x07: RS-Helios-1615， RS-Helios-16P 

Resv 32 10 Reserved for future updates 

Note: The time stamp is used to record the time of the sensor system, with a resolution of 1us. Please refer to the 
definition of time in Appendix B.13. 
 



                                                  RS-Helios-16P User Manual                                                                                                        

 19 

 
 

6.2.2 Data Blocks 

As shown in the table below, the Data Blocks in the MSOP packet store the data measured by the 

sensor, and has a total of 1200 bytes. There are a total of 12 data blocks in one MSOP Packet. Each 

data block has 100 bytes and represents a complete measurement. Each data block starts with a 

2-byte flag: Oxffee, followed by a 2-byte azimuth value (horizontal rotation angle), and 32 channel 

data (each channel data has 3 bytes) corresponding to 2 firing sequences of the 16 lasers (channel 

data 1… to channel data 32). Please refer to Section 6 of this manual for the relationship between 

channel number and vertical angle. 

The MSOP packet structure of single return data is as shown in the figure below: 

 

 Figure 12 MSOP Packet Definition of Single Return Data  

42 bytes 
(byte 21 to 
30 store 
timestamp 

4 bytes 
reserved  
* 
2 bytes 
(0x00,0xF
F) 
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The MSOP packet structure of dual return data is as shown in the figure below: 

 

Figure 13 MSOP Packet Definition of Dual Return Data  

6.2.2.1 Channel Data 

Each channel data has 3 bytes, the upper two bytes store distance information, and the lower one 

byte stores reflectivity information, as shown in the figure below. 

Table 10 Channel Data  

Channel  data n （3 bytes） 

2 byte Distance 1 byte Reflectivity 

Distance1 [15:8] Distance2 [7:0] Reflectivity 

42 bytes 
(byte 21 to 
30 store 
timestamp 

4 bytes 
reserved  
* 
2 bytes 
(0x00,0xF
F) 

 
 
 
First return 

 
 
 
 
Second return 
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Distance information contains 2 bytes, the unit is cm, the resolution is 0.25cm. 

 

Figure 14 MSOP Packet 

Note: 

Red Box: Header ID; 

Orange Box: Data Block flag; 

Blue Box: Azimuth value of Channel data 1; 

Green Box: Distance value of Channel data 1. 

1. Calculate distance based on distance data in 

the data packet: 

1) Find the distance value in the data packet and 

convert to a hexadecimal number: 0x01 ,0x40 

2) Convert to a 16bit unsigned integer: 0x0140 

3) Convert to a decimal number: 320 

4) Calculate according to the distances resolution 

5) Result: 320*0.25 = 8m 

2. Calculate azimuth based on azimuth data in 

the data packet: 

1) Find the azimuth value in the data packet and 

convert to a hexadecimal number: 0x88，0xdb 

2) Convert to a 16bit unsigned integer: 0x88db 

3) Convert to a decimal number: 35035 

Divided by 100 

4) Result: 350.35 degrees 

 

 

6.2.2.2 Azimuth Value 

The azimuth value of each data block is the azimuth value reported by the first laser of the firing 

sequence of this data block. Azimuth value is recorded by angle encoder with the zero position of 

the angle encoder corresponding the zero degree of the azimuth value. The azimuth resolution is 

0.01 degrees. In fact, each data block contains 32 channel data, corresponding to the data of the 

16 lasers in two firing sequences, each data block reports only one azimuth value, therefore, in 

the single return mode, the azimuth value of each data block is the azimuth value recorded in the 

first channel data of the first 16-laser firing sequence in this data block, and the azimuth of the 

first laser firing in the second 16-laser firing sequence needs to be processed and obtained by 
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interpolation (please refer to Section 6.2.2.3 for the interpolation method). 

6.2.2.3 Azimuth Value Interpolation 

Because the RS-Helios-16P reports the azimuth value for every-other 16-laser firing sequence, 

when the LiDAR works in single return mode, for the firing sequence which does not report the 

azimuth value, it’s helpful to interpolate the un-reported azimuth value. There are several ways to 

interpolate the un-reported azimuth value, but the one given below is the easiest one.  

In one data packet, the time interval between the first channel data collection of block N(N is the 

number of the block, N≥1) and the first channel data collection of block N+1 is ~100us, assuming 

that the LiDAR rotates at a constant speed during this period. Therefore, the azimuth recorded by 

the first channel data of the N+1 firing sequence can be calculated as the mean azimuth value of 

the azimuth value recorded in the first channel data of the N firing sequence and that of the N+2 

firing sequence.  

The following pseudo-codes detects whether the azimuth passes from 359.99 to 0 degrees from 

the Nth group to the N+2nd group. Set N=1 as follows: 

// First, adjust for a rollover from 359.99° to 0° 

If (Azimuth[3] < Azimuth[1]) 

Then Azimuth[3]:= Azimuth[3]+360; 

Endif; 

// Perform the interpolation 

Azimuth[2]:=Azimuth[1]+((Azimuth[3]-Azimuth[1])/2); 

// Correct for any rollover over from 359.99° to 0° 

If (Azimuth[2]>360) 

Then Azimuth[2]:= Azimuth[2]-360; 

Endif 

6.2.3 Tail 

The Tail is 6 bytes in length, among which 4 bytes are reserved, and the other 2 bytes are 0x00 and 

0xFF.  

6.3 Device Info Output Protocol（DIFOP） 

Device Info Output Protocol is abbreviated as DIFOP 

I/O type: device output, computer read. 

Default port number: 7788. 

DIFOP is an "output-only" protocol to periodically send the LiDAR serial number (S/N), firmware 

version information, host computer driver compatibility information, network configuration 
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information, calibration information, motor operating configuration, operating status, and fault 

diagnosis information to users. By reading DIFOP, users can learn specific information of various 

parameters of the LiDAR currently in use. 

A complete DIFOP packet consists of a synchronization header, data area and a tail. Each DIFOP 

Packet is 1248-byte long, including an 8-byte long synchronization header, 1238-byte long data 

area and a 2-byte long tail.  

The structure of the DIFOP packet is as shown in the table below. 

Table 11 DIFOP Packet Structure 

Segments No. Information Registers Offset Length（byte） 

Header 
0 DIFOP identification header 0 8 

Data 

1 Motor speed 8 2 

2 Ethernet  10 22 

3 FOV setting 32 4 

4 Reserved 36 2 

5 Motor phase lock 38 2 

6 Top board firmware version number 40 5 

7 Bottom board firmware version number 45 5 

8 Bottom board software version  50 5 

9 Motor firmware version number 55 5 

10 Sensor hardware version number 60 3 

11 Web page cgi version number 
63 4 

12 Top board backup CRC 
67 4 

13 Bottom board backup CRC 
71 4 

14 Software app backup CRC 
75 4 

15 Web page cgi backup CRC 
79 4 

16 Ethernet gateway 
83 4 

17 Subnet mask 
87 4 

18 Reserved 91 201 

19 Serial number 292 6 

20 Zero angle offset 298 2 

21 Return mode 300 1 

22 Time Synchronization Mode 301 1 

23 Synchronization status 302 1 

24 Time 303 10 

25 Operating status 313 12 

26 Reserved 325 17 

27 Fault diagnosis 342 18 

28 Whether the code wheel is calibrated 360 1 

29 GPS PPS pulse trigger mode 
361 

1 
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30 Reserved 362 20 

31 GPRMC 382 86 

32 Corrected vertical angle 468 48 

33 Reserved 516 48 

34 Corrected horizontal angle 564 48 

35 Reserved 612 634 

Tail 
36 Tail 1246 2 

Note: The Header (the DIFOP identifier) in the table above is 0xA5,0xFF,0x00,0x5A,0x11,0x11,0x55,0x55, it can be 
used to identify the packet. The tail is 0x0F,0xF0. 

For detailed definition of information registers as well as their usage, please refer to Appendix B 

of this user manual.  
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7 Vertical Angles and Exact Point Time Calculation     

7.1 Channel Number and Vertical Angle   

RS-Helios-16P has a vertical field of view from -15°to +15° with uniform vertical resolution of 2°. 

The 16 laser heads are also called 16 channels. The laser channels and their designated vertical 

angles are as shown below. 

 

 

Figure 15 RS-Helios-16P Vertical Angles  

7.2 Exact Point Time Calculation 

In each MSOP Packet, there are 12 data blocks, and each data block stores measurements of 2 

firing sequences of 16 lasers, therefore, each MSOP Packet records 24 firing sequences of 16 lasers. 

It takes 55.56us to complete one round of firing and recharging of the 16 lasers. The exact point 

timing of different lasers in single return mode and dual return mode can be calculated according 

to the time offsets listed in the tables below:  

 

 

 

 

 

 

 

 

 

 

 

+15° 

0° 

-15° 
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Table 12 MSOP Packet Time Offset of Exact Laser Point Timing in Single Return Mode  

 

 

Table 13 MSOP Packet Time Offset of Exact Laser Point Timing in Dual Return Mode  
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8 Troubleshooting  

When using the sensor, users may encounter some common problems, this chapter lists some 

common problems and the corresponding solutions. 

Problem Solution 

The red LED indicator in the  

Interface Box is off or blinking 

 Check whether the input power connection and polarity are 

normal. 

LiDAR motor does not rotate  Check whether the LED indicators on the Interface Box are 

normal. 

 Check if the connection cable between the Interface Box and 

the LiDAR gets loose. 

LiDAR keeps restarting at 

startup 

 Check whether the input power connection and polarity are 

normal. 

 Check whether the voltage and current of the input power 

supply meet the requirements (12V voltage input, input 

current≥2A). 

 Check whether the mounting base of the device is level or 

whether the fixing screws at the bottom of the LiDAR are too 

tight. 

LiDAR rotates but no data 

output 

 Check whether the network connection is normal. 

 Check whether the computer network configuration is 

correct. 

 Use another software (such as wireshark) to check whether 

the packet output is normal. 

 Turn off firewalls and other security software that may block 

the network. 

 Check whether the power supply is normal 

 Try to restart the sensor 

Can see data in Wireshark 

but no point cloud in RSVIEW 

 Turn off the computer firewall, and allow the RSVIEW to 

bypass the firewall. 

 Make sure that the IP of the computer is consistent with the 

IP of the LiDAR. 

 Make sure that the Data Port setting on RSVIEW is correct. 

 Make sure that the RSVIEW installation directory or 

configuration file storage directory only contain English 

characters. 
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 Make sure that the data packets received by wireshark are 

MSOP packets. 

Frequent data dropouts 

 Check whether there is excessive traffic and/or collisions on 

network. 

 Check whether there are other network devices in the 

network sending excessive broadcast packets, which slows 

the sensor down. 

 Check whether the computer or the interfaces are fast 

enough to meet the packet flow requirements. 

 Remove all other network devices and directly connect sensor 

to the computer to test whether there is packet loss. 

 

GPS/PTP not synchronizing 

 Make sure that the synchronization mode has been switched 

to the correct mode on the web page 

 Make sure that the GPS baud rate is 9600bps and serial port 

set to 8N 1(8 bits, no parity, 1 stop bit). 

 Check whether the GPS signal level is 3.3V TTL or RS232  

 Make sure that the 1PPS pulse is continuous and the 

connection is correct 

 Make sure that the GPRMC message of NMEA is correct 

 Make sure that the GPS and Interface Box share the same 

ground 

 Make sure that the GPS has received valid message 

 Make sure that the GPS module is outdoors 

 Check if the PTP Master synchronization protocol complies 

with the current PTP protocol 

 Check if the PTP Master is working properly 

No data output when sensor 

connected to a router 

 Turn off the DHCP function of the router or set the IP of the 

sensor to the correct IP inside the router 

In the point cloud, there is a 

fixed blank area that 

continuously rotates 

 This phenomenon is normal, because the ROS driver performs 

frame display according to a fixed number of packets, and the 

blank part of the data will be displayed in the next frame 

 

RSVIEW software outputs 

point cloud into a ray 

 If you are using a windows 10 system, please set RSVIEW to 

run in the mode compatible with windows 7 
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Appendix A Web Interface  

RS-Helios-16P can only be accessed and controlled by its Web Interface, through which users can 

perform various operations on the RS-Helios, including setting LiDAR parameters, viewing LiDAR 

operation status, updating firmware, etc. There are mainly four screens of the LiDAR Web Interface, 

namely the Device, Setting, Diagnostic, and System. The specific definitions on the functionality 

and feature of each screen is explained in the following pages. 

The RS-Helios-16P web address changes with the LiDAR IP. The factory default LiDAR IP is 

192.168.1.200. If the user has changed the LiDAR IP, the web address will be changed to the newly 

set IP address. 

After the LiDAR is correctly connected and configured according to the requirements, user can use 

the computer connected to the LiDAR to access the LiDAR IP address (default Device IP 

"192.168.1.200") to enter the homepage of the LiDAR web interface, the homepage defaults to the 

"Device" page. 

A.1 Device Information Screen 

After accessing the LiDAR Web Interface, you will be at the “Device” screen directly, which shows 

information of the LiDAR currently in use: 

 

 

1. Top Board: the top board firmware version;  

2. Bottom Board: the bottom board firmware 

version; 

3. Software Version: the software version; 

4. Motor Firmware Version: the firmware 

version of the motor;  

5. Hardware Version: the hardware version; 

6. S/N: the sensor serial number; 

7. Model: the product model number. 

 

Figure A-1 Homepage of the Web Interface 

A.2 Device Parameter Setting Screen 

Click the Setting button on the Web Interface, you will open the “Setting” screen, where you will 

find settings for Device IP, port number, return mode, rotation speed, etc. can be done at the 

General Setting page, and settings for angle phase at the Angle Phase Setting page. Definition of 

the functionality and features are as shown in the figure below: 
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Figure A-2 General Setting Page of the Web Interface 

 

1. Communication of LiDAR supports both unicast (default) and broadcast modes. Destination IP 

address 255.255.255.255 indicates broadcast mode. The default factory setting of the LiDAR IP is 

192.168.1.102 

2. The MSOP and DIFOP port numbers can be configured in a range from 1025 to 65535; 

3. The Return Mode has four options: Strongest(default), Last, First, and Dual; 

4.The FOV can be set from 0° to 360°, when set, only the point cloud of the set FOV will be output.   

5. The sensor rotation speed can be set, which only 600rpm(default), and 1200rpm are supported 

at the moment; 

6. The Time Synchronization Source has options: GPS, PTP-P2P, PTP-E2Eand PTP-gPTP; 

7. Click the dropdown menu of "Operation Mode", users can select the working mode between 

Standby and High Performance (default). When the Standby mode is selected, the LiDAR motor 

and transmitter will stop working. 
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Figure A-2.2 Angle Pulse Setting Page at the Web interface 

1. Angle Pulse Setting: Set the angle pulse triggering feature, which by default is turned off.  

2. Trigger Mode: There are two starting angle trigger modes. Mode1 means that the starting pulse 

width is increased by 25% (default), and Mode2 means that the starting pulse width is not 

increased; 

3. Group Switch: Turn on/off the "Pulse Trigger Switch", when "All On" is checked, all groups of 

SYNC angle pulse trigger settings are activated for setting. The Group Switch is by default checked 

"All Off"; 

4. Group: Referring to SYNC OUT group. The RS-Helios-16P integrated sensor cable has reserved 

the SYNC_OUT1 pin and the SYNC_OUT2 pin, but the Interface Box has reserved only the 

SYNC_OUT1 pin. Please refer to Table 2 GPS Port Definition for more details. Therefore, only [First 

Group] is available, the Second Group can be set but is not available; 

5. Pulse Trigger Switch: Turn on /off the “Pulse Trigger Switch” of a specific group of SYNC angle 

pulse trigger settings, when “ON” is checked, the settings are activated for editing, when not 

checked, the settings turn grey and are not editable.  

6. Pulse Start Angle: Setting the starting angle, the default value is 0, and the resolution is 0.1 

degrees.  

7. Pulse Width: Setting the pulse width, the default value is 10ms, and the resolution is 20ns, the 

maximum duty cycle is 50%;   

8. Pulse Step: Setting the pulse step pitch, the default value is 360 degrees, and the resolution is 

0.05°. 



                                                  RS-Helios-16P User Manual                                                                                                        

 32 

Note:  
1. The Device IP and the Destination PC IP must share the same network segment, otherwise the connection won’t 
be successful; 
2. The MSOP and DIFOP port number can be set from 1025 to 65535, and the MSOP port and DIFOP port cannot 
be set to the same port; 
3. After every modification of the settings, you will need to click the Save button, if the system prompts “setting is 
successful”, the new settings will take effect.  

A.3 Device Diagnostic Screen  

Click the Diagnostic button on the front page of the Web Interface, you will see the Diagnostic 

Screen, where you can learn the operating status of the sensor in real time, including the input 

voltage, current, sensor rotating speed, operating time, and temperature. The figure below shows 

the Diagnostic screen and the features:  

 

Figure A-3 Diagnostic Screen at the Web Interface 

Description:  
1. Voltage Monitor: shows the voltage of the sensor input power supply in real time. When the 
LiDAR Operation Mode is set in the Standby mode, the input box will turn red; 
2. Temperature: users can view the current operating temperature of the LiDAR;  
3. RPM: shows the LiDAR rotating speed in real time;   
4. Laser Status: users can choose from “ON” (default) or “OFF”, if the LiDAR Operation Mode is set 
in the Standby mode, the laser status is “OFF”.   
5.Start-up Times: users can learn the total number of start-up times of the LiDAR up to data, each 

power circle counts 1 star-up.  
6. Elapsed time Total TO: users can view the total operating time of the LiDAR and the total 

operating time under different temperature range respectively.  

Note： 
1. The diagnostic screen is refreshed every second.  
2. If the voltage/current box turns red, please check whether the LiDAR is currently in Standby mode, if not, check 
whether the LiDAR is working normally;  
3. The number of start-up times is refreshed after 1 minute after the LiDAR is circle powered again, and the 
operating time is refreshed every 1 minute.  
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A.4 Device/System Upgrade Screen  

Click the System button on the front page of the Web Interface, you will see the System Screen, 

where you can update the top board firmware, bottom board firmware, software, web and motor 

firmware. The procedure of firmware update, taking the Top Board Firmware Update as an example, 

are as shown below:  

1. Prepare the Top Board firmware that is going to be used for the update. Click the Choose File 

button to navigate to the folder where the new TOP Board firmware is located.  

 

Figure A-4 Click Choose File to Find the New Firmware 

2. Select the right firmware that is going to be used for the update, and click Open to upload 

the file. (The saving path of the firmware should only contain English characters)  
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Figure A-5 Select the Right Firmware 

3. When the new firmware is successfully uploaded, the file name of the firmware will appear 

in the box behind the Top Board Firmware Update, click Update to initiate the update process.  

 

Figure A-6 Click Update 
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4. After the Update process completes, the Web Interface will prompt Update Successful, and 

the LiDAR will automatically restart, after the sensor is restarted, load the Web Interface again 

to check if the firmware update is successful.   

 

Figure A-7 Update Successful  

 

Note: The upgrade package name must meet the following requirements before it can be upgraded 
normally, otherwise an error will be reported: 
·Top board upgrade file: The necessary prefix "helios_top”. The necessary suffix ".bin" 
·Bottom board upgrade file: The necessary prefix "helios_bot_" The necessary suffix ".bin" 
·Software upgrade file: The necessary prefix “helios_app_" The necessary suffix ".elf" 
·Web App upgrade files: The necessary prefix "helios_cgi_" The necessary suffix ".tar.gz" 
·Motor upgrade file: The necessary prefix "helios_mot_" The necessary suffix ".hex" 
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Appendix B Information Registers 

Here are definitions and more details on the information registers as mentioned in Section 6. 

B.1 Motor Speed (MOT_SPD) 

MOT_SPD (2 bytes in total) 

Byte No.  byte1 byte2     

Function MOT_SPD     

Register description: 

(1) This register is used to configure the motor rotation direction and motor speed; 

(2) The data storage adopts the big-endian format.  

(3) Supported rotation speed: 

(byte1==0x04) && (byte2==0xB0): speed 1200rpm, clockwise rotation; 

(byte1==0x02) && (byte2==0x58): speed 600rpm, clockwise rotation; 

If set with data other than the above described, the rotation speed of the motor is 0. 

B.2 Ethernet（ETH） 

ETH (22 bytes in total） 

Byte No.   byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 

Function LIDAR_IP DEST_PC_IP 

Byte No.   byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16 

Function MAC_ADDR port1 

Byte No.   byte17 byte18 byte19 byte20 byte21 byte22   

Function port2 port3 Port4  

Register description: 

(1) LIDAR_IP is the source IP address of the LiDAR. It takes 4 bytes 

(2) DEST_PC_IP is the IP address of the destination PC. It takes 4 bytes 

(3) MAC_ADDR is the LiDAR MAC address. 

(4) port1 to port4 are port number information.  

port1 is the port for LiDAR to output MSOP packets and port2 is the port for destination PC to 

receive MSOP packets. port3 is the port for LiDAR to output DIFOP packets and port4 is the port 

for destination PC to receive DIFOP packets. By default, we suggest port1 and port2 to be set the 

same, port3 and port4 to be set the same. 
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B.3 FOV Setting（FOV_SET） 

FOV_SET (4 bytes in total) 

Byte No. byte1 byte2 byte3 byte4   

Function FOV_START FOV_END   

Register Description: 

Set the azimuth range that the sensor can output valid data, the values of FOV_START and 

FOV_END could be any integer between 0 to 36000, corresponding 0~360°, the data storage adopts 

the big endian ordering. For example: byte1 = 0x5d，byte2 = 0xc0，byte3 = 0x1f，byte4 = 0x40, 

therefore: 

FOV_START = 93*256+192=24000 

FOV_END = 31*256+64=8000 

Which indicates that the azimuth range for valid data output is from 240.00° to 80.00° in clockwise 

direction. 

Note: In all above calculations, bytes have been converted from hexadecimal to decimal. 

B.4 Motor Phase Offset (MOT_PHASE) 

MOT_PHASE(2 bytes in total) 

Byte No. byte1 byte2     

Function MOT_PHASE     

Register description: 

This register can be used together with the PPS pulse of GPS to adjust the phase offset of the motor 

at the top of seconds. The value can be set from 0 to 360 corresponding 0 to 360°. The data storage 

adopts the big endian ordering. For example: the byte1=1, byte2=14, so the motor phase should 

be 1*256+14 = 270. 

Note: In all above calculations, bytes have been converted from hexadecimal to decimal. 

B.5 Top Board Firmware Version (TOP_FRM) 

TOP_FRM(5 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5  

Function TOP_FRM  

Register description： 

This register corresponds to the top board firmware version: 

Register value: 00 01 06 05 00 

Segmentation of value: 0x0001060500 

Top board firmware version: 01060500  
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B.6 Bottom Board Firmware Version(BOT_FRM) 

BOT_FRM(5bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5  

Function BOT_FRM  

Register description： 

This register corresponds to the top board firmware version: 

Register value: 00 01 03 01 00 

Segmentation of value: 0x0001030100 

Bottom board firmware version: 01030100 

B.7 Motor Firmware Version(MOT_FRM) 

MOT_FRM (5 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5 

Function MOT_FRM 

Register description:  

This register corresponds to the motor firmware version: 

Register value: 00 21 11 23 21 

Segmentation of value: 0x0021112321 

Motor firmware version: 21112321 

B.8 Software Version(SOF_FRM) 

SOF_FRM (5 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5 

Function SOF_FRM 

Register description: 

This register corresponds to the Software Firmware version:  

Register value: 00 22 04 18 01 

Segmentation of value: 0x0022041801 

Motor firmware version: 22041801 

B.9 Corrected Vertical Angle(COR_VERT_ANG) 

COR_VERT_ANG(48 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 byte9 

Function Channel 1 vertical angle Channel 2 vertical angle Channel 3 vertical angle 

Byte No. byte10 byte11 byte12 byte13 byte14 byte15 byte16 byte17 byte18 



                                                  RS-Helios-16P User Manual                                                                                                        

 39 

Function Channel 4 vertical angle Channel 5 vertical angle Channel 6 vertical angle 

Byte No. byte19 byte20 byte21 byte22 byte23 byte24 byte25 byte26 byte27 

Function Channel 7 vertical angle Channel 8 vertical angle Channel 9 vertical angle 

Byte No. byte28 byte29 byte30 byte31 byte32 byte33 byte34 byte35 byte36 

Function Channel 10 vertical angle Channel 11 vertical angle Channel 12 vertical angle 

Byte No. byte37 byte38 byte39 byte40 byte41 byte42 byte43 byte44 byte45 

Function Channel 13 vertical angle Channel 14 vertical angle Channel 15 vertical angle 

Byte No. byte46 byte47 byte48       

Function Channel 16 vertical angle   

Register description: 

(1) The channel vertical angle value is composed of 3 bytes, among which the 1st byte is used to 

indicate positive/negative angle, the 2nd and 3rd bytes indicate angle value. The data storage adopts 

big-endian format; 

(2) The 1st byte of the vertical angle value, 0x00 means a positive angle, 0x01 means a negative 

angle; 

(3) The angle resolution: LBS=0.01;  

(4) For example, the register value of channel 1: byte1=0x00, byte2=0x05(converted to decimal is 

5), byte3=0xd6(converted to decimal is 214), then the vertical angle of channel 1 is: (5*256+ 

214)*0.01=14.95°. 
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B.10 Corrected Horizontal Angle(COR_HOR_ANG） 

COR_HOR_ANG(48 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 byte9 

Function Channel 1 horizontal angle  Channel 2 horizontal angle Channel 3 horizontal angle 

Byte No. byte10 byte11 byte12 byte13 byte14 byte15 byte16 byte17 byte18 

Function Channel 4 horizontal angle Channel 5 horizontal angle Channel 6 horizontal angle 

Byte No. byte19 byte20 byte21 byte22 byte23 byte24 byte25 byte26 byte27 

Function Channel 7 horizontal angle Channel 8 horizontal angle Channel 9 horizontal angle 

Byte No. byte28 byte29 byte30 byte31 byte32 byte33 byte34 byte35 byte36 

Function Channel 10 horizontal angle Channel 11 horizontal angle Channel 12 horizontal angle 

Byte No. byte37 byte38 byte39 byte40 byte41 byte42 byte43 byte44 byte45 

Function Channel 13 horizontal angle Channel 14 horizontal angle Channel 15 horizontal angle 

Byte No. byte46 byte47 byte48       

Function Channel 16 horizontal angle   

Register description:  

(1) The channel horizontal angle value is composed of 3 bytes, among which the 1st byte is 

used to indicate positive/negative angle, the 2nd and 3rd bytes indicate angle value. The data storage 

adopts big-endian format;  

(2) The 1st byte of the horizontal angle value, 0x00 means a positive angle, 0x01 means a 

negative angle; 

(3) The angle resolution: LBS=0.01;  

(4) For example, the register value of channel 1: byte1=0x01, byte2=0x01 (converted to decimal is 

1), byte3=0x96 (converted to decimal is 150), then the vertical angle of channel 1 is: -

（1*256+150）*0.01=-4.06° 

B.11 Serial Number(SN） 

SN(6 bytes in total) 

Byte No. 1byte 2byte 3byte 4byte 5byte 6byte 

Function SN 

Similar to the MAC address, it indicates the serial number of the LiDAR with a total of 6 bytes in 

hexadecimal. 
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B.12 Software Version（SOFTWARE_VER） 

This register describes the version compatibility of the host computer. 

B.13 UTC Time（UTC_TIME） 

UTC_TIME (10 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 

Function sec us 

Byte No. byte9 byte10       

Function us       

Note: the range of ns is from 0 to 999999999. 

B.14 STATUS（STATUS） 

STATUS (18 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 

Function Idat1_reg Vdat Vdat_12V_reg Vdat_5V_reg 

Byte No. byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16 

Function Vdat_2V5_reg Vdat_APD Internal debug 

Byte No. 17byte 18byte 19byte 20byte 21byte 22byte 23byte 24byte 

Function Internal debug 

Byte No. 25byte 26byte 27byte 28byte 29byte    

Function Internal debug   

Note:【Value】is the decimal value calculated after the byte at the corresponding position, in big-endian mode, 

with the high order first and the low order last.  
 

Register description: 

(1) Idat is the current of the LiDAR power supply. The current value is composed of 2 bytes. Current 

calculation formula: 

Idat=Value_temp/4096 *5A 

For example, when byte1 = 0xc8, byte2 = 0x02, the actual current value: 

Idat =Value_temp/4096 *5A= 0x02c8/4096 *5A =0.87A 

(2) Vdat has 5 different voltage values, each voltage value has 2 byte, calculation formula of the 5 

voltages are as below: 

SOFTWARE_VER(2 bytes in total) 

Byte No. byte1 byte2     

Function SOFTWARE_VER     
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Vdat = value/4096  V 

Vdat_12V_reg = value /4096 * 24.5V 

Vdat_5V_reg = value / 4096x11 V 

Vdat_2V5_reg = value / 4096x10 V 

Vdat_APD  = 516.65*(value)/4096-465.8 V(negative value)   

The unit above is volt (V). 

B.15 Fault Diagnosis（FALT_DIGS） 

FALT_DIGS (40 bytes in total) 

Byte No. byte1 byte2 byte3 byte4 byte5 byte6 byte7 byte8 

Function  temperature1 temperature2 temperature3 temperature4 

Byte No. byte9 byte10 byte11 byte12 byte13 byte14 byte15 byte16 

Function temperature 5 r_rpm lane_up lane_up_cnt Top_Status 

Byte No. byte17 byte18 byte19 byte20 byte21 byte22 byte23 byte24 

Function Top_Status GPS_Status Internal debug 

Byte No. byte25 byte26 byte27 byte28 byte29 byte30 byte31 byte32 

Function Internal debug 

Byte No. byte33 byte34 byte35 byte36 byte37 byte38 byte39 byte40 

Function Internal debug 

Note:【Value】is the decimal value calculated after the byte at the corresponding position, in big-endian mode, 
with the high order first and the low order last. 

 
Register description:  

(1) temperature2, temperature3, temperature4 are temperatures of other boards. Temperature 

calculation formula: 

Temperature2&3&4=200*（value）/4096-50 

temperature1, temperature5 are the temperature of the top board/bottom board FPGA chip 

respectively. The temperature value is composed of 2 bytes, and the calculation formula is:  

                   Temperature1&5=503.975*(value)/4096-273.15

 (2) byte18 is the GPS signal input status register gps_st. This register uses 3 bits to indicate whether 

the currently connected PPS signal and GPRMC signal are valid, and to indicate whether the current 

system time is the local count time of the sensor or the synchronized UTC time. The bit definitions 

are as follows: 

 GPS_ST 

Byte No. Function Status Description 

bit0 
PPS flag: 

PPS_LOCK 

0 PPS signal is invalid 

1 PPS signal is valid 
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bit1 
GPRMC flag: 

GPRMC_LOCK 

0 GPRMC signal is invalid 

1 GPRMC signal is valid 

bit2 
UTC Lock flag: 

UTC_LOCK 

0 LiDAR internal time is not synchronized with UTC time 

1 LiDAR internal time is synchronizing with UTC time 

Bit3 
GPRMC Input 

Status 

0 No input 

1 With input  

Bit4 PPS Input Status 
0 No input 

1 With input  

bit5~bit7 Reserved x N/A 

(3) The real-time speed of the motor is composed of byte32 and byte33. The calculation formula 

is as follows: Motor real-time speed = value 

For example, when byte32 = 0x58 and byte33 = 0x02, r_rpm=0x0258=600rpm. 

(4) Other registers are used for internal debugging. 

B.16 GPRMC Data Packet-ASCII Code Data Type  

86 bytes are reserved for the GPRMC data packet. According to the length of the GPRMC message 

output by the external GPS module, the received GPRMC message is self-adaptively stored and can 

be analyzed and viewed in ASCII code. 
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Appendix C RSView 

This appendix gets you started with RSView. It shows you how to use RSView to acquire, visualize, 

save, and replay RS-Helios-16P data. You can also use other free tools, such as Wireshark or tcp-

dump. But for data visualization, RSView a more convenient and easier to use. The version used 

here is RSView3.1.7. 

C.1 Software Features 

RSView provides real-time visualization of 3D LiDAR data from RS-Helios-16P. RSView can also 

review pre-recorded data stored in .pcap (Packet Capture) files, but RSView still does not support 

playing .pcapng files.  

RSView displays distance measurements of RS-Helios-16P as point cloud data. It supports custom-

colored display of variables such as intensity-of-return, time, distance, azimuth, and laser ID. The 

data can be exported in CSV format. The RSView 3.1.3 or later version supports generating LAS 

format point cloud files, while the previous versions of RSView do not support generating point 

cloud files in LAS, XYZ, or PLY formats. 

Functionality and features of RSView include:  

 Visualize live streaming sensor data over Ethernet 

 Record live sensor data to pcap files 

 Visualize sensor data from a recorded pcap file 

 Different types of visualization modes, such as distance, time, azimuth, etc. 

 Display point data in a spreadsheet 

 Export point cloud data in CSV format 

 Distance measurement tool 

 Display multiple frames of data simultaneously (Trailing Frames) 

 Display or hide subsets of lasers 

 Crop views 

C.2 Install RSView 

Installer for RSView is provided for Windows 64-bit system and there is no need for other 

dependencies. You can download the latest installer from RoboSense website 

(http://www.robosense.ai/resource). Launch the downloaded installer and follow the instructions 

to finish the installation. After installation is completed, a shortcut will be generated on the desktop. 

Make sure the installation path only contains English characters.  

http://www.robosense.ai/resource


                                                  RS-Helios-16P User Manual                                                                                                        

 45 

C.3 Set Up Network 

As mentioned in Section 2, the LiDAR has a factory default IP address to be sent to computer. 

Therefore, by default, the static IP address of the computer needs to be set to 192.168.1.102, and 

the subnet mask needs to be set to 255.255.255.0. In addition, you need to make sure that the 

RSView is not blocked by firewalls or third-party security software.  

C.4 Visualize Streaming Sensor Data 

1. Connect RS-Helios-16P to power and connect to computer by network cable. 

2. Right Click to start the RSView application with Run As Administrator. 

3. Click on File > Open and select Sensor Stream (Figure C-1). 

 

Figure  C-1  RSView Open Sensor Stream 

4. The Sensor Configuration dialog will appear. In “Type of Lidar”, chose RSHelios-16P. In “Intensity”, 

chose Mode3. Then click OK, as shown in Figure C-2: 

 

Figure C-2 Select RS-Helios-16P Parameter Configuration File  

5. RSView begins displaying the data stream (Figure C-3). The streaming can be paused by pressing 

the Play button, pressing again, the streaming resumes. 
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Figure C-3 RS-Helios-16P Data Streaming in RSView 

C.5 Capture Streaming RS-Helios-16P Data to PCAP File 

1. Click the Record button when streaming (Figure C-4).  

 

Figure C-4 R RSView Record Button. 

2. In the “Choose Output File” dialog that pops up, set the save path and file name, and then click 
the Save (S) button (Figure C-5). RSView will start to write the packet file into the target pcap file. 
Note: RS-Helios-16P will generate huge volume of data. As the recording time becomes longer, the target pcap file 
will become larger. Therefore, it is better to save the recorded file to the HDD or SSD instead of a slow subsystem 
such as a USB drive or network drive. 

 

Figure C-5 RSView Record Saving Dialog. 
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3. Click the Record button again to stop saving pcap data.  

C.6 Replay Captured Data from PCAP File 

You can use RSView to replay or check the pcap file saved from RS-Helios-16P. You can press the 

Play button to play or select frames in the data that you are interested in. You can also use the 

mouse to select a portion of 3D point cloud which the details will then be tabulated in a 

spreadsheet for analysis. The saving path of the pcap file should only contain English characters. 

1. Click File > Open and select Capture File 

 

Figure C-6 Open the pcap record file 

 

 

 

 

 

 

 

2. In the pop-up “Open File” dialog, select a recorded pcap file and click Open (O).  
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Figure C-7 Open Recorded pacp File 

3. In the pop-up “Sensor Configuration” dialog, add and select the correct RS-Helios-16P 

configuration file and click the OK button. 

4. Click the Play button to play or pause the data. Use the Scrub sliding tool to slide back and forth 

to select frames at different positions in the data. This tool and the Record button are in the same 

toolbar (Figure C-8) 

    

Figure C-8 RSView Play Button and Scrub Tool 

5. In order to get a more detailed analysis, select a frame of data that you are interested in and 

click the Spreadsheet button (Figure C-9). A sidebar data table will be displayed on the right side 

of the screen, which contains details of all the data of this frame 

   

Figure C-9 RSView Spreadsheet Tool. 

 

 

 

 

 

 

6. You can adjust the width of each column of the table, or sort to get a better view. 
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Figure C-10 RSView Spreadsheet Display  

7. Click Show only selected elements in Spreadsheet to get the data corresponding to the selected 

points (Figure C-11). 

 

Figure C-11 RSView Show only selected elements Tool  

8. Click the Select All Points tool, which turns your mouse into a data point selection tool (Figure 

C-12). 

 

Figure C-12 RSView Select All Points Tool 

9. In the 3D rendered data pane, use your mouse to draw a rectangle to frame some data points. 

The data of these points will immediately populate the Spreadsheet and the selected data points 

will turn pink in the data pane (Figure C-13). 
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Figure C-13 RSView List Selected Points Tool  

 

10. Any selected points can be saved via Spreadsheet>Show only selected elements>Output CSV 

data. 

C.7 Set RSView Data Port 

The default MSOP port number of RS-Helios-16P is 6699, and the default DIFOP port number is 

7788. If these two port numbers of RS-Helios-16P are modified in the means described in Section 

C.7 in other ways, you will need to reset the Data Port that RSView acquires data to the modified 

port number, otherwise there will be no data display. If you don’t know the MSOP port number 

and DIFOP port number of RS-Helios, you can connect LiDAR to the computer and use Wireshark 

to capture LiDAR packets to view the Dst Port information. 

Click Tools> Data Port, enter the modified RS-Helios-16P MSOP Port and DIFOP Port, and click Set 

Data Port. 

 

Figure C-14 Set Port Number  
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Appendix D RS-Helios-16P ROS&ROS2 Package 

This appendix explains how to use Ubuntu+ROS or Ubuntu+ROS2 to acquire and visualize RS-

Helios-16P data. 

D.1 Install Software 

1. Download and install Ubunutu 16.04 /18.04/20.04 operating system. (ROS2 users are imperative 

to use the Ubuntu 18.04/20.04 system) 

2. ROS users: Install and test the basic functions of ROS Kinetic according to the link 

(http://wiki.ros.org/kinetic/Installation ). (For Ubuntu 18.04 users, please install ROS-melodic) 

ROS2 users: Install and test the basic functions of ROS2 Eloquent according to the link 

(https://index.ros.org/doc/ros2/Installation/Eloquent/). 

3. Download and install libpcap-dev. 

D.2 Download & Compile RoboSense LiDAR Driver Package 

You can get the latest LiDAR driver package from https://github.com/RoboSense-

LiDAR/rslidar_sdk, or contact our technical support to get it. After downloading, please read the 

README file in the driver package carefully, which describes in detail how to compile and use the 

LiDAR driver package. 

rslidar_sdk is our latest LiDAR driver package, which has included drivers for five mechanical 

LiDAR sensors: RS-16, RS-32, RS-BP, RS-Ruby and RS-Helios-16P. Three compilation modes are 

supported: 

1. Direct Compilation 

The user enters the main directory of the rslidar_sdk driver package and creates a build folder to 

compile and run.  

mkdir build 

cd build 

cmake .. && make 

./rslidar_sdk_node 

2. Compilation in ROS 

Create ros working directory: 

cd ~ 

mkdir -p catkin_ws/src 

Copy the rslidar_sdk driver package to the ROS working directory ~/catkin_ws/src. Open the 

CMakeLists.txt file in the rslidar_sdk driver package, and change the set(COMPILE_METHOD 

ORIGINAL) at the top of the file to set(COMPILE_METHOD CATKIN). At the same time, rename the 

package_ros1.xml file in the driver package to package.xml., and change the LiDAR type in the 

http://wiki.ros.org/kinetic/Installation
https://index.ros.org/doc/ros2/Installation/Eloquent/
https://github.com/RoboSense-LiDAR/rslidar_sdk
https://github.com/RoboSense-LiDAR/rslidar_sdk
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config/config.yaml file in the driver package to RSHELIOS_16P. 

Run the following command in the terminal to compile: 

cd ~/catkin_ws 

catkin_make 

3. Compilation in ROS2 

Create ros2 working directory: 

cd ~ 

mkdir -p catkin_ws/src 

Copy the rslidar_sdk driver package to the ROS2 working directory ~/catkin_ws/src. Open the 

CMakeLists.txt file in the rslidar_sdk driver package, and change the set (COMPILE_METHOD 

ORIGINAL) at the top of the file to set (COMPILE_METHOD COLCON). At the same time, rename 

the package_ros2.xml file in the driver package to package.xml, and change the LiDAR type in the 

config/config.yaml file in the driver package to RSHELIOS_16P. 

Run the following command in the terminal to compile: 

cd ~/catkin_ws 

colcon build 

D.3 Configure PC IP 

In the default RS-Helios-16P firmware, configure the static IP address of the computer to 

"192.168.1.102", the subnet mask to "255.255.255.0". The gateway does not need to be configured. 

After the configuration is completed, you can use the ifconfig command to check whether the static 

IP takes effect. 

D.4 Real Time Display 

There are detailed documents in the rslidar_sdk project to guide how to display the point cloud in 

real time in the ROS or ROS2 environment. Here is a brief introduction, taking the ROS environment 

as an example.  

1. Connect RS-Helios-16P to computer with a network cable, power it on and run, and wait for the 

computer to recognize the LiDAR. 

2. Run the launch file provided in the rslidar_sdk driver package to start the node program that 

displays data in real time. The launch file is located in rslidar_sdk/launch/start.launch. Open a 

terminal and run: 

cd ~/catkin_ws 

source devel/setup.bash 

roslaunch rslidar_sdk start.launch 
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Figure D-1 rviz displays RS-Helios-16P point cloud data  

 

D.5 View Offline Data 

About how to parse data offline (rosbag or pcap), there is also a detailed introduction in the 

documentation in the rslidar_sdk driver package. Here is just a brief introduction, taking pcap as 

an example. You can use rslidar_sdk to parse the saved offline pcap file into point cloud data for 

display. 

1. Modify the parameters in rslidar_sdk/config/config.yaml 

msg_source: modified to 3 

pcap_directory: configure to the absolute path of the pcap file: 

(e.g./home/robosense/RSHelios.pcap) 

2. Open the terminal and run the node program:  

cd ~/catkin_ws 

source devel/setup.bash 

roslaunch rslidar_sdk start.launch 
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Appendix E Mechanical Drawings 
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Appendix F Sensor Cleaning 

In order to be able to accurately sense the surrounding environment, RS-LiDAR needs to be kept 

clean, especially the optical ring lens. 

F.1 Attention 

Please read the contents of this appendix F carefully and completely before cleaning RS-LiDAR, 

otherwise improper operation may damage the sensor. When the LiDAR is used in a harsh 

environment, it is necessary to clean up the dirt on the surface in time to keep the LiDAR clean, 

otherwise it will affect the normal use of the LiDAR 

F.2 Required Materials 

1. Clean fiber cloth 

2. Spray with neutral warm soap 

3. Spray with clean water 

4. Isopropanol solvent 

5. Clean gloves 

F.3 Cleaning Method 

If there is only some dust adhered to the surface of the sensor, you can directly dip a small amount 

of isopropanol solution with a clean fiber cloth, and then gently wipe the LiDAR surface to clean, 

and then wipe it dry with a clean fiber cloth. 

If the surface of the LiDAR is caked with mud or dirt, first spray clean water on the surface of the 

dirty part to remove the mud or the dirt (Note: Do not try to wipe off the mud directly with a fiber 

cloth, as this may scratch the surface, especially the optical ring lens.). Secondly, spray warm soapy 

water on the dirty parts (The lubricating effect of soapy water can accelerate the detachment of 

the dirt). Gently wipe the surface of the sensor with the fiber cloth again, be careful not to scratch 

the surface. Finally, clean the soap residue on the surface with clean water (If there are still residues 

on the surface, use an isopropyl alcohol solution to clean it again), and wipe it dry with a clean 

microfiber cloth. 
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